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Starting Appointments

1. Tolaunch the appointment scheduler, double-click the Citrix icon on the desktop

a. Open the Appointment CS folder (if necessary).
b. Double click the Appointment icon.

Appoinkrment

C. After a moment, the Login screen will appear

ppointmentsCS

lized Scheduling

tware is licensed to:

SpectraHealth Medical Center
Serial Number : DM2001-1

Yergsion Number : 8.21

Copyright © 1954-2004 SpechaSalt Inc. All rights reserved.

User |DEM|:|| mewﬂ oK | Caneel

2. Type your User ID and Password.
3. Click OK

Once you log in successfully, Appointments will initialize and the main scheduling screen will be
displayed.
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Appointments Main Screen
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Nomeable Poge Tobs

Main Menu
Use the menus to access your data maintenance and program configuration options.

Main Toolbar
The toolbar buttons are shortcuts to frequently used functions regarding client and appointment

maintenance.

Demographic Window Pane
This section of the main screen displays the selected client's key demographic information.

Resource Headers
The Resource Headers display the current Treatment Staff in use for each scheduling column. These are

broken down into three types of resources, Psychiatrist, Therapist, and Other Provider Staff.

Time Column
The time column displays time increments equal to the default clinic timeslot.

Nameable Page Tabs
Create custom views of treatment staff by assigning page tabs to groups of resources.

Exiting Appointments
The preferred method for exiting Appointments is to select <File> then <Exit> from the main menu.
In addition, select <File> then <Login User> if you step away from your desk, so that client
information is not displayed and no one can use the program with your ID and password while
you’re away.
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Navigational Calendar

Use the Navigational Calendar to select days for scheduling or for printing reports. It provides a quick,
visual means of selecting a date to view appointments or to schedule appointments. Simply place the cursor
over the day you desire to use and click the left mouse button.

Month and Year Arrows —_— ”I ’ I March 2002 t I Itl
Sun Mon Tue ‘'Wed Thu Fri  Sat
24 2h 268 27 2B i z

Active or Selected Date _ 4 I R E T g e
m 11 12 12 14 15 1k
17 12 19 20 21 22 23
&4 25 28 2F &8 Z28  I0

Go to today button 1 | = = T tr I

Month and Year Arrows

Click the left and right double arrows to move the year backward or forward. Click the single arrows to
move the month backward or forward. Alternatively, right click on the month header in the center of
the calendar (e.g., March 2002 in the illustration above) to quickly select a month 3 months previous to
the current month or 3 months in the future.

Active/Selected Date
The active date determines the day on which you are scheduling an appointment and it determines

the default starting date for any function that requires a date range: for example, reports, setting
blocks and hold times, and recurring appointments.

Go to Today Button

Click the Go to Today button to return to Today's date and to make it the active day. However, when
you click the Go to Today button in the Weekly or Monthly views, the program will simply display
the week or month in which Today's date occurs. The Go to Today button does not change the
display to the Daily view. You must manually select Daily View from the View menu.
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Options Menu

The Options menu appears anytime you right click a time slot or appointment on the scheduling grid. It

will display only those options that are available for the time selected. Options that are unavailable are

displayed in gray.

Daka
Blaok Appt
Edir
Record Paymane
o Make and Edit
Agpt History Make and Edit are scheduling functions used to make new or edit existing appointments. They serve the
HairLit same function as the Make Appointment and Edit Appointment buttons on the main toolbar.
Pending
Confirmed
i Blank Appt
i:d Use the Blank Appointment option to override a template hold or a block time. This clears a resource
o Show schedule so that appointments can be made in previously reserved time slots. This is not for use with regular
Cur client appointments or individual block and hold times.
Gopy.
D,;_, Appt History
Raichaduls Use the Appointment History option to view the specific history of the selected appointment. This is an
51:: alternate shortcut to the same screen that is available on the client’s Appointments tab.
H,
Select Clieat
Pending No-show

Appointments are “pending” until they have been marked
as Arrived or Seen, or until they have been Cancelled or
marked No-show. If the status of an appointment is
mistakenly marked as Arrived or Seen, click Pending on the
Options menu to change the status back to pending.
Inadvertent cancellations or no-shows must be corrected
on the Check-in screen.

Confirmed
Select Confirmed when a client confirms or acknowledges

beforehand they will attend the appointment.

Arrived
Click Arrived to mark a client as having arrived. The current

system time will be used as the arrival time. Change this
on the Check-in screen.

Seen
Click Seen to mark a client as having been seen. The

current system time will be used as the seen time. Change
this on the Check-in screen.

Cancel
Click Cancel to cancel an appointment. The appointment

will be removed from the scheduling grid and statistics
about the appointment will be stored with the client’s
history for reporting purposes.

Click No-show to mark a client as such. The appointment
will be removed from the scheduling grid and statistics
about the appointment will be stored with the client’s
history for reporting purposes.

Cut, Copy, Paste, and Delete
These serve the same function as described for the

buttons of the same name on the main toolbar.

Reschedule
Reschedule is used to move appointments using a limited

“find appointment” function. It is the only means users
have to move multi-segment appointments (they can’t be
copied). Reschedule will keep the same relational order of
each segment of the appointment: For example if the
client was scheduled to see Resource A half an hour before
Resource B, etc.

Block and Hold
Block and Hold serve the same function as described for

the Block and Hold buttons on the main toolbar.

Select Client
Use the Select Client option to choose any client or group

on whose appointment you right clicked to get the Options
menu. Select Client will only be active when you right click
on a client or group appointment. Blank times, blocks and
holds will not activate it.
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Scheduling

Making an Appointment
The following illustrates the basic skills required to schedule an appointment, including

a) selecting a client
b) selecting a resource
c) making a single resource appointment

When you successfully log in to the program and select any day in the current calendar year, you should
see a screen similar to the following:
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B » g o 3 | =
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MR Humber ‘whork Phone : =T & 5 0 5 G P L
Home Phone Birth Date 7 & 8 om N BB 5 i
Primary Insurarice Sew: Age L I B T - - g -
Fi yph 8 . 2 222 24 26 22 fa &
(SR TR 2z 29 0 M 1 2 3
Practitioner 4 5 B 7 8 2} .
Green, Mark, Rapier, Riobert C Nightingale, Flarence Examination Room 1 Examination Room 2 Conference Foom whirlpaol F2
0300 A Tt of the Office
‘iggin, Kate Douglas
$0.00
03:30 A = IH|Physical therapy evaluatil
wsical therapy
05:45 A B " H]
™
0300 A
0345 A
™
0330 A
03:45 A
Zampieri, Domenichia
f0:00 AR M| augh, M= Evelyn A&
10:15 AR
10:30 A
1045 481
7 Alired L
1400 Ab H  NewPatient Intake e 1234
Aquatic therspy witherapsy
1115 A H Ty
11:30 Ak H " =
4| | Bause __I_I

Note: The Scheduler uses color coding to enable users and viewers to
easily recognize if a client is new, a time slot is double booked, and
there is an available time slot. The following are a list of the colors and
their definitions

Color Definition
Black Client seen before; had prior services at the clinic.
Red New appointment; no open episode.
Yellow Designated time; no appointment to be scheduled.
Blue Time slot double booked
Gray Appointment blocked; treatment staff member unavailable.
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Selecting an Appointment Date

The first thing you'll want to do when you make an appointment is select an appropriate date for the
appointment using the Navigational Calendar. Simply place the cursor over the day you desire to use
and click the left mouse button.

X% The current grid date is the date selected on the Navigation Calendar. It is the "active" date and
often determines the start of functions that involve a date in Appointments. Appointments

defaults to today’s date when first opened.

Selecting a Client

Once you have selected a date, you will want to select a client to schedule.
Begin typing the Client's Last Name

1. Begin typing a client’s last name while the main scheduling screen is displayed. Simply typing the client’s last name will pull
up the Client select screen.

2. Once the screen appears, simply continue typing the client's last name. As you type, only those clients whose last name
matches what you have typed to that point will be displayed in the select screen. A "selection" arrow will point to the
first of those clients.

3. Once you locate the client you wish to select, click his or her name once and then click OK to select that client.
Alternatively, double-click the client's name.

4.  You will be returned to the main scheduling screen and the client’s information will be displayed in the Demographic
panel.

Alternatively, start by clicking the Client Select button on the toolbar to display the Client select &

screen. Once the screen appears, click in the Search box and begin typing the client’s name.

Box T.1 How to Use the Data Selection Screens

Any time you click a select button with the ellipses _l or click a button S
labeled Select, a screen similar to that shown here will appear. Patient |
Searc:h:lS
If the select dialog in which you’re working has more than one column of sort I~ Non Domain Speciic Search
data, you can click the column headers to change the sort order. The [~ Show Only New Palisnts
illustration here is sorted by Description. To sort by ID, click the column S g;i;”"a";:ey |'803388383838 [ssti=
header “ID.” The ID column will “snap” to the first column of the dialog and || Smythe, Paulina Maris e ——
the information will be sorted on ID instead of Description. || Stanton, Elzabeth C STAND387433
|| Stowe, Hariet B Stow38934794 8384
|| Stuart, James E Stus3308347 | 3894
| | Szold, Elizabeth H SZ0L3003347
To select an item,

1. Choose a “Sort By” option by clicking the column header or by
selecting one from the drop-down menu.

2.  Click the Search field once.

3. Begin typing the ID or Description depending on your Sort By _ILI
option. As you type, an arrow in the column to the left of the ID KT x
column will align or point to the first item that most closely o By: [Deseription =
matches what you have typed. New

4. Continue typing the description or ID. Once the arrow points to Help oK Cancsl

your selection, click OK to select the item.

Alternatively, you can simply use the scroll bar to move up and down the list to display the description you desire.
1. Choose a “Sort By” option that arranges the records in the order that best suits your current needs.
2. Place the cursor on the scroll bar.
3. Click and hold the left mouse button down while dragging the scroll bar up or down to locate the desired description.
4. Once located, double-click the description to choose your selection.
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Selecting a Resource

Generally, each user’s scheduler display will be configured for the clinic he or she works in and each time
the program is started the user’s screen will display the same basic information.

|
To place a resource in a scheduling column, do the following: Resnrcs |
Eamch
. . orrawr | ¢ arsuriy Cours -
1. Left click the resource column header and the Resource Select screen will appear. . "1 Wenrek st
crnsca Ty [T - |
2. Click the drop-down menu in the Domain field and choose your clinic. !ﬁuu ]E,ﬂ, s 1=l
| | By, Movuls
Lk COGGER TATHLEEN
3. Click the drop-down menu in the Resource Type field and select the desired resource [ DELOMG. &ROE &
B Ganns, Catwera
type (Psychiatrist, Therapist, or Other Provider Staff). | ]enn Tiac, Boends -
Bl Hald Jorathar,
o] e sk, Lirch
4. Once the correct list of resources is displayed, click the name of the resource you want - ';;,;. LTr‘-;Fs .
| (ARD, LEITH & ;I
to select and then click OK and that resource will appear in the column header you O |
selected.
| Co ] o |

Making a Single Appointment
Once a date, a client, and a resource are selected, an appointment can be scheduled.

1. Place the cursor over the first of any open (blank) time slots and click and hold the left mouse button down.

2. While holding down the left mouse button down, drag the cursor to the last cell necessary for the length of the

appointment and release the mouse button.
3. Place the cursor over any of the selected cells and click the right mouse button to display the Options menu.

4. Click Make. The Edit Appointment screen will appear.

— i

Szold, Elizaboth H MR Horbe  S20LY00EMTN Viome Phone - (8025555550

CaelD [STNFEBHTH =]  Wedk Prone - EOZEES 555
Papreeri Srimead 4100

[Proceduus | inswctors | Biagnoss | -
|_l_l |

Dl‘llwtdu Zddddiorad Info

Monday. A 13,2004, & 0300 AM

™ Facumg "l' i MM
r Use dggl Y.-neﬁnh- ProcedureP rocedure Group
S| _ x| o |
™ Mon Diomain Specific Search
5. This screen allows you to attach procedures and comments to a specific appointment. = “‘"""m:‘m | 3
! o Lol Inpatenl AWOL
a. Click the Add button to bring up the Procedure select screen. :::; e
b.  Once the screen appears scroll through or click in the Search box and type in I I e
the appropriate procedure code by ID or Description. :R'é e i o PO
c.  Once you locate the Procedure you wish to select, click it once and then click T e
OK to select it. Alternatively, double-click the procedure. Hi Sus o9
d. Verify the duration in the Edit Appointment screen, and click OK E};‘;' B
Il :;; ;::r;:?uaa:,e
6. After a moment, you’ll be returned to the main screen, where you can view the | | =
appointment that was just scheduled. e | fw |
e | [k ] gea |
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Making a Recurring Appointment

1. Follow the procedures for making a Single Resource Appointment and after entering the procedure code, click the

recurring checkbox in the Edit Appointment screen and then click OK.

=
Seold, Elizabet H o
Com i) [FEosieitT =] Woek Prore BOZERS S8
Monday, Api 19,2004, & (90020 Pagrent [rieed - 5000
[Pz | insmicteons | Disgnoms | oD .|
R
T |
Lt 2 =
Oofad dppsrman Eaddbioral Infa Dusation
I Frcumng [ = e
I Use gt T Coken
| _ o | o |

2. The Recurring Appointments screen will appear

Recurring Appoiniments

Szold, Elizabeth H

 Dal  Bitwaekl
& Waskly [
Starting [10711/2002 @ Endng [13/25/2003 &1
I+ Check lee canflicts whie making Appls
EveryWeek On
I Sunday F Thusscay
I~ Monday I Fiday
 Tuesdzy I Saluday
I~ Wadnasday
Hoo | @ | g |
3. Select the interval for the appointment, if Weekly is chosen the lower portion with the days of the week becomes
active.
4.

Select the starting and ending dates (and days of the week where appropriate) for the appointment series and
click OK.

The appointments will be scheduled. If any conflicts are detected, you will be given the opportunity to book
“all” appointments, only the “open” appointments, or to “cancel” the operation.

Moving an Appointment

1. Place the cursor over any of the time slots for an appointment and click the right mouse button once to pull up the
Options menu and click cut, or select an appointment and click the cut icon. '3{

2. A dark screen or shading will cover the selected appointment (if the appointment color is black, you won't see the
shading).

3. Place the cursor in the time slot where you want the new appointment to begin and click the right mouse button
again and when the Options menu reappears, click Paste, or select the new time slot and click the paste icon. The
appointment will be moved to the new start time. &

Copying an Appointment

Copy is useful to create multiple appointments of the same type for a client. Copy differs from “recurring”
appointments in that it provides a visual method of using the grid to see what time slots are available for
the given resource by viewing weekly or monthly schedules for a single resource.

1. Place the cursor over any of the time slots for an appointment and click the right mouse button once to pull up the

B
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Options menu and click copy, or select an appointment and click the copy icon.

2. A dark screen or shading will cover the selected appointment (if the appointment color is black, you won't see the
shading).

3. Rightclick the column header of the resource to whom you would like to copy the appointment Clear Calumn
and a popup menu will appear. v Dally Yiew

4. Choose weekly or monthly view to see the resources extended schedule. - "

Monthly Wiew

5. Select the time slot where you want the appointment to begin. This will select the time. If Patisnt Yiew
necessary, select other time slots by holding down the control key and clicking.

6. Once you have finished selecting time slots, click the Paste button on the main toolbar. The appointment will be
copied to each time you selected. &

Finding an Available Appointment SRR Ahe BRBRNA|xYE A MEELA 4 49

1. Select the client to be scheduled. ;ﬂ‘%ﬁ

2. Right click the Treatment Staff’s name in the Resource Header and EE S :"
select Monthly View in the popup menu that appears. ]

3. Navigate by month using the Navigational Calendar or the forward :E
or back arrows at the bottom of the screen. o

4. Select the necessary available timeslots. =

5. Follow the procedure for making a single or recurring appointment LE
as required. e :

i —— e P oo G

Verifying an Appointment
To verify an appointment when a client calls in to confirm, reschedule, or cancel an existing appointment:

1.
2.

Follow the procedures for selecting the client.
Once the client demographics are displayed, left click the yellow “Client Appointments” icon to display the @
client’s appointment history, including future appointments -

[ Appointments - Zampéen Domenichio 5
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Appointment Check-in

The Appointment Status or “Check-in” screen provides a good reference to all the clients scheduled and the
resources with whom they are scheduled for any given day. The schedule report this screen provides is also
useful tool to check in clients manually as they arrive. You can then refer to it when you need to enter the
information into Appointments. There are several methods for maintaining appointment status.

1.  Place the cursor over any of the time slots for an appointment and click the right mouse button once to pull up the

Options menu.
2. Select the appropriate check in action.

a. Select Arrived. The current time will record automatically.

Confurmad
b. Select Canceled or No-show. The reasons screen will appear. Select a reason and R
click OK and the appointment is removed from the grid and the reason stored in the 9‘:”
client’s appointment history.
3.  The Options menu closes.
Another method is to access the Appointment Status screen
1.  Click the Client Check-in button on the main toolar from the main menu. The Appointment Status \‘ﬁ’\l

(Check-in) screen will appear.

2. Locate an appointment and click the drop-down arrow in the Status column for that appointment to display the list of

Appointment Status OpthnS.
Clignt Check In |
Time Client [Phone [Resaurce Hame [ived  [Seen  [Status [Confimd
W— RAKWENA, HENRY Pending No
|| =00 AM TORRES. KAREN & Fending No
|| 08:30 Akt ettt Engs, Kari Pending No
|_|0=:20 AM slfonzo, Imelda Pending Mo
|_|03.00 40 FOnGioBBIHoOOOON  REXRIBGOER  Enge, Kari Fending No
|| 0900 AM } Schi Altonzo, Imelda Pending Mo
0920 AM Enge, Kari Fending No
: 03:30 A6 Altonzo, Imelda Pending Mo
|| 0950 AM S IR Enge, Kari Fending No
|| 10:00 A Altonzo, Imelda Pending Mo
|_|10:20 AM Alfonso, Imelda Fending No
|_[10:30 Akt QUALLS, 54RAH Pending No
|_|17:00 AM slfonzo, Imelda Pending Mo
|| 171:00 Ak Enge, Kari Fending No
|_|17:00 AM SMITH. BRENDA G Pending No
| 17100 A MIEIBODEREEXIOOK (309 - SMITH, BRENDA G Fending No -
[l | |
Help Closeout Day | PintDay | [100772003 ] Domaine |Phoenis Comuniy Counselin =] Close

a. Select Arrived. The current time will fill automatically in the Arrived column. Edit the time as necessary.

b. Select Canceled or No-show. The reasons screen will appear. Select a reason and click OK and the

appointment is removed from the grid and the reason stored in the client’s appointment history.

3. When you finish, simply click Close.
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Block and Hold Times
Block times are used to schedule non-client activities such as lunch, meetings, vacations, etc. They indicate
times that a resource specifically does not want to schedule clients, but they can be overridden.

Hold Times are used to indicate that the available times are specifically for designated types of
appointments, but they will accept any type of appointment.

Scheduling Block and Hold times is similar to scheduling recurring appointments.

1. Click a time slot for a resource and drag the cursor to select the required timeslots. ey foee ]

Form—y T ——
2. Click the right mouse button on any of the selected cells to display the Options e S . = 4
menu. ~ Gy r g ey
A by
Select Block or Hold. The appropriate Time screen will appear. -
W e | [ ey |
4, Click the Select button in the Reason field to display a select screen of reasons and
B Dot i rvvtin: aps sompy it [isis
select the appropriate reason. Fhe T Tt
i i
I s

Leave the "Check for conflicts" option selected to make
sure that the block time you are creating does not feen
conflict with any previously scheduled appointments

or block times.

5. Click the radio button next to the appropriate Occurs option.
6. If the Block or Hold time occurs Weekly, choose the appropriate days on which to apply the block.

7. The Starting date in the Duration section defaults to the active grid date. Click the calendar button in the

Ending field to display a drop-down calendar and choose an ending date.

8. Click OK when finished.

Block and Hold times can take a minute or two to complete.

Client Reminder Letters

Once a single appointment or a series of appointments are booked, a customized reminder letter can be
printed for a client containing the date and time of each appointment for the date range specified, the
resource(s) that the client will be seeing, any scheduled procedures, and any instructions you might have
for the appointment.

To print an Appointment Reminder Letter

]

Click the Client Reminder button on the main toolbar. A
2. The Client Reminder Letter screen will appear and the information for the
currently selected client will populate the report automatically. Seecta ange of dees for e repa
3. The "Select a range of dates" field defaults to the current month. Change this Start Dale End Dale
[ &262004 =] [inone) |
as needed.
Select a Patient for the report
4. The "Select a Client" field will default to the client selected currently. Click [ b |
the Select button to choose a different client or accept the default. St e o
5. The "Select a Domain" field will display the current clinic. Click the Select Frysial Theopy ]
Select a Reminder Letter for the report.
button to choose an alternate. —
6. Click the Select button in the "Select a Reminder" field to choose which S
reminder letter to use for the current report. E‘ B —— _ ‘
- L |

7. If necessary, click the printer button in the Current Printer window to select
an alternate printer. Otherwise click Preview or Print to output the report to your destination choice.
a. Preview will print to screen, where the report can be printed or save to a file.

b. Print will output the report to your selected printer.
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Terminology

Block Time: Resource timeslots that are not available for client appointments.
Domain: The treatment location or clinic, analogous to the Reporting Unit.

Hold Time: Resource timeslots that are primarily available for designated types of client
appointments.

Resources: The treatment staff of the clinic or location that provide client services.
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